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Thank you for taking the trouble to try this program out. We hope you like it.

Note: this file is formatted and is best read with SimpleText and not TeachText.

Note: this file is not read-only so that you can easily copy the text if you want to. For e-
xample, you can copy the email addresses and URLs. Please donʼt modify this file or 
distribute modified versions.

Note: you should scroll up and down a pageful at a time so that the pictures will appear 
properly. If the pictures donʼt appear, you can make them appear by scrolling up a page 
and then back down a page.

This software is copyrighted material and therefore you are not allowed to modify this 
software or its documentation in any way, shape or form, nor can you sell it for your own 
profit. You may only charge a reasonable fee for the cost of distributing it. See the Dis-
tribution section below for information about how and on what IIe may be distributed.
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1. Read me first

Itʼs best to begin with a word of warning:

IIe is a complex program and has some powerful features. You can easily lose Apple //e 
data by using this program “recklessly” so please do these two things:

(1) make a backup of all your important data and disk images, and
(2) read these documents thoroughly. By reading these documents, youʼll understand 
how IIe works and how to use it safely and usefully.

You can disregard this warning to your own consequence. It will be pointless to com-
plain to me that you lost your work. My reply will be: why didnʼt you read the instructions 
and make a backup? Of course I want IIe to work as reliably and as safely as a real //e 
would. Nevertheless, there are probably some minor bugs in this program, so itʼs best to 
be safe and always have a backup.

OK, that out the way, letʼs define some of the terms used below before getting started. 
The term “IIe” refers to this Mac program. In contrast, the term “//e” refers to the virtual 
Apple //e that you use in the “Apple //e” window, ie the virtual computer and not the Mac 
program and its menus, windows, dialogs, etc. Donʼt worry. Itʼll make more sense as you 
read along.

If you insist on reading the very minimum, you should at least peruse the Frequently As-
ked Questions which are at the bottom of this document.

What is it? - description, features, requirements, compatibilty, and performance issues

Description:

IIe is an Apple //e emulator for Macintoshes and PowerMacintoshes. It lets you run vir-
tually any program for the Apple II, Apple II Plus, Apple //e, and Apple //c computers. It 
does not run Apple IIgs software.

It has been tested with a limited number of programs and works well with them. Most of 
the Apple II OSes boot up, including DOS 3.3, ProDOS 2.0.3, and Apple Pascal 1.2. 
Most games will work without problems. See below for more details about this versionʼs 
abilities and limitations.



How does it work? IIe takes machine instructions written originally for the 65c02 micro-
processor and emulates them in software. In other words, it uses the CPU in your Mac 
to do the work that was originally intended for a 65c02 microprocessor. The emulator 
keeps track of the 65c02 instructions, registers and memory usage, as well as conver-
ting the memory used for graphics or text into Macintosh graphics. As well, Apple II pe-
ripherals such as the Disk II (5 1/4" disk drive), and the UniDisk for 3 1/2" floppy disks 
are also emulated.

The goals of version 3 are more functionality and compatibility. New to version 3 are 
these features:

• sharp graphics - no more hard to read hires text!
• faster PowerPC emulation of 65c02 instructions (the emulator is now written in Po-
werPC assembly, using pipelining, branch prediction, and several optimisations that are 
only possible with assembly code)
• ability to ignore illegal opcodes
• ability to emulate a 6502 instead of a 65c02
• ability to paste text into an Apple II program
• support for more screen sizes from as small as 640 * 400 (PowerBook) to larger than 
14" screens
• added an option for a joystick that doesnʼt auto-centre when you use the keypad
• drag and drop support for easier loading of disk images
• no longer requires you to quit IIe when you change slots (except that memory cards 
may not get the requested memory size until you allocate more memory to IIe by chan-
ging its size in the Finder)
• more peripherals such as printer card support - you can now print from your Apple II 
program to your Mac printer (text only)
• support for the original Disk II boot ROM (necessary for some disks to boot)
• more drives: the Mac-ProDOS card now supports two drives and the UniDisk card can 
support up to 4 drives in ProDOS when installed in slot 5
• can now eject real 3 1/2" disks from the Mac when you remove them from the //eʼs dri-
ve
• more compatible I/O space functioning for some programs that require random num-
bers (such as Castle Wolfenstein)
• can disable the 80 column card for Pascal programs which run better in 40 column 
mode (such as Wizardry)
• support for a user-selectable beep sound
• user-adjustable joystick limits (necessary for some games)
• you can now run the emulator at full speed - that is, as fast as your Macʼs CPU will run 
it
• and last but definitely not least, numerous bug fixes

This version (3.0.1) fixes a few more bugs and has a few new features:

• supports keyboard input from the keypad when the joystick is the mouse and not the 
keypad



• you can now save the //e screen to a PICT file (the Dump command in the File menu)
• fixed problems with some programs like Wings of Fury
• no longer crashes when printing with some programs

Features:

• comes as a “fat binary” - that is, it contains both 680x0 and PowerPC code for optimal 
performance on any Mac. This version performs quite well on 68040 Macs and Power-
Macs and performs “decently” on 68030 Macs. 68040 Macs should get 1Mhz //e per-
formance. PowerMacs should be able to get 2MHz //e performance or better.

• able to display an Apple //e computer in a Mac window. This version supports all the 
//e graphics modes: text, lores graphics, double lores graphics, hires graphics, and 
double hires graphics. It even flashes text. The normal and alternate (“MouseText”) cha-
racter sets are supported. The hires and double hires graphics can be displayed in mo-
nochrome or colour. Text and hires graphics displayed in monochrome mode can be 
displayed in a variety of monochrome colours such as white, green or amber (read that 
sentence twice if you didnʼt get it the first time)

• able to take keystrokes on your Mac keyboard and pass them to the emulated //e. 
Supports the “open” (command) and “closed” (option) apple keys on the //e keyboard 
(as well as the third paddle button by the shift key - known as the “shift key modificati-
on”).

• the //e can be reset from your Mac keyboard (by pressing control-delete)

• able to read 5 1/4" disk and 3 1/2" disk images - this version supports all common i-
mage formats including 5 1/4" nibble images

• able to read directly from a 3 1/2" disk in the internal drive on your Mac and use it as a 
3 1/2" disk in the emulator

• able to use a ProDOS partition of your hard disk as a ProDOS hard disk in the emula-
tor. You can set up such a partition with “Apple HD Setup” or “FWB Hard Disk Toolkit”.

• able to directly read from or write to files in a Mac directory from any ProDOS program. 
This is a very handy feature and allows direct transfer of data without the need for PC 
Exchange

• supports fast reads and writes on Dos 3.3 and ProDOS 5 1/4" disks

• able to switch any disk in any drive at any time

• emulates a joystick by using the keypad on your Mac keyboard or the mouse



• emulates a RamWorks III RAM disk

• emulates peripherals such as a ThunderClock clock card, the AppleMouse mouse 
card, the Apple II Memory Expansion memory card, and a serial card with ImageWriter 
printer attached

• very configurable via an easy-to-use preferences and setup dialog

• supports Apple //e speaker sounds

• has a useful debugger to allow you to set breakpoints, inspect registers, etc. if you 
want to debug Apple II programs

Hardware and software requirements:

IIe requires:

• a colour-capable Macintosh (ie, not the Mac Plus, SE, Portable, or PowerBook 100). A 
fast 68030 Mac is the minimal hardware you should run IIe on. All PowerBooks except 
the PowerBook 100 can run IIe.

• a monitor of at least 640 * 400 pixel size (sorry to the 12" colour and Colour Classic 
owners)

• System 7 or later

• the Thread Manager (which is built into System 7.5 or later).

• Sound Manger 3.0 or later.

Recommended:

• a fast 68040 Mac or a PowerMac

• support for 256 colours

• System 7.5.1 or later

• Sound Manger 3.1 if you have a PowerPC Mac

• Thread Manger 2.1 if you have a PowerPC Mac

• Macintosh Drag and Drop if you are not running System 7.5 or later



• a ProDOS partition on your Mac hard disk (created with Appleʼs HD Setup program or 
a third party utility such as FWBʼs Hard Disk Toolkit) or a ProDOS hard disk image (u-
sing one of the files supplied in this package).

Compatibility:

This software has been tested on systems 7.1 to 7.5.3.

Currently there are no known Mac software conflicts. If you should find a problem, let 
me know.

With regard to Apple II software, there are some programs (especially games) that re-
quire special configuration to work properly with IIe. These are the known ones:

• Castle Wolfenstein image on www.asimov.net - requires the Disk II be in “compatible” 
mode not “fast” mode (or you can copy a normal DOS 3.3 onto it)
• Karateka - requires the original (“dumb”) Disk II ROM to boot up
• Legacy of the Ancients - requires “ignore illegal instructions” to boot up
• Championship LodeRunner - requires the joystick x and y maxima be set to about 270 
for play with the joystick
• Wizardry I (and probably the others as well) - requires the boot disk to be write protec-
ted (ie, locked) otherwise it will be destroyed by the program when you first boot it. If 
you don't like the 80 column text, click the 80 column card icon in the slots pane to 
switch it to 40 columns.

If you know of any other conflicts or problems, let me know and I'll investigate it and up-
date the list as necessary.

Performance issues:

This version does not allow background programs much background time to run so you 
may find print jobs tend to slow down and modem downloads donʼt work well. Similarly, 
programs that take up background time will tend to slow down the emulator (because 
your Macʼs CPU spends less time running the emulator). Even having a lot of other pro-
grams open will slow down the emulator - merely closing those other 6 apps will bring a 
noticable speedup in the program! :-)

For best performance:

• close all unecessary programs
• reduce the number of extensions you install at startup
• run IIe in Black & White mode (ie, 1-bit mode) - the fastest graphics blitters are the 1-
bit blitters because they have the smallest amount of memory to blit
• use the small window size



• use direct drawing

Installation and setup

Simple installation/setup

To install and set up this program:

1) decompress the archive that this program comes in. Youʼve probably already done 
this to be able to read this Read Me.

2) get a copy of the Apple //e ROMs*. If youʼre on the internet, you can get it from:

http://www.asimov.net/pub/apple_II/emulators/applepc/IIerom.zip

If youʼre on an online service, use its ftp ability to obtain the above file.

Use a utility such as “DropStuff with StuffIt Expander” or “ZipIt” to decompress the file.

*For legal reasons, the ROMs cannot be distributed with this emulator because they are 
the copyright of Apple Computer, Inc. “So what?” you might ask. Well, I personally donʼt 
enjoy getting letters from lawyers, and since I still own an Apple //e (and it still works just 
fine thanks), I have all the ROMs I need (well, almost all: if only Iʼd bought that mouse 
card, memory card, serial card, etc. etc. when I could have...).

If you donʼt have internet access but do have a real Enhanced //e*, you can follow these 
instructions to create your copy of the ROMs. You will need some way of transferring 
the file to your Mac such as a 3 1/2" floppy disk or some kind of serial connection. Ask 
your nearby user group for info about how to do this.

Note that in the following lines, the ʻ0ʼ character is a zero, and that anything between 
angled brackets ʻ<ʼ or ʻ>ʼ is one character - eg, <control-C> means hold down the con-
trol key and then press the C key (which is an invisible character).

Also, note that the ROMs in the Apple IIe card for Mac LCs are modified and will not 
work with IIe.

  a) start up your //e and boot up ProDOS. Then run BASIC.SYSTEM to enter Applesoft 
Basic (it will display a ʻ]ʼ prompt)
  b) type “call-151<return>” to enter the //eʼs monitor program (it will then display the ʻ*ʼ 
prompt)
  c) type “2000<D000.FFFFM<return>”
  d) type “C007:0<return>”
  e) type “5100<C100.CFFEM<return>”
  f) type “C006:0<return>”



  g) type “<control-C><return>” to re-enter Basic
  h) type “BSAVE APPLE2E.ROM,A$1000,L$5000”
  i) transfer this file to your Mac as a binary file

* Enhanced //eʼs have a 65c02 processor and when you run programs like AppleWorks, 
they will display folders and characters such as the open and closed apples on the text 
screen. Unenhanced //eʼs have a 6502A processor and donʼt have the special charac-
ters so AppleWorks ʻlooks funnyʼ.

3) make sure the ROM file is called “APPLE2E.ROM” and that it is in the same folder as 
IIe. If you want to see the icon for ROMs, change the type/creator of the file to ʻROMsʼ/
ʻAIIeʼ.

4) set IIeʼs memory size. IIeʼs memory size is preset at 1700K (it will appear as about 
2065K on PowerPC Macs with virtual memory off), which is optimal for 68K Macs using 
a 256K table which helps the emulator run faster. You can change this setting depen-
ding on what kind of Mac you have and whether you want to use the table:

• if you have a PowerPC Mac, you can set IIeʼs memory size to 1200K if you have virtu-
al memory on (or if you have RamDoubler on), or to 1565K if you have virtual memory 
off. If you set IIe to use more memory in the form of RAM disks, etc. then of course 
youʼll have to use larger values (depending on the size of your extra memory require-
ments).

• if you have a 680x0 Mac and set IIe to not use the 256K table, then you can reduce 
IIeʼs memory size to 1500K. DO NOT set IIe to any value below 1500K or it may crash 
or behave erratically.

You are now set to use IIe. Read the information below and in the following documents 
to learn how to properly use it.

Tips

• changing the creator of a disk image to ʻAIIeʼ allows you to double click the file to have 
IIe use it
• clicking the Mono/colour icon button changes the display from monochrome to colour 
and vice versa
• control-clicking the Mono/colour icon button changes the colour of the monochrome 
text/graphics
• option-clicking the Mono/colour icon button changes the screenʼs bit depth from 8 -> 1 
-> 4 -> 8, etc.
• control-esc or F15 will start/stop the emulator
• be sure to have backups of your Apple II disks because IIe can destroy the disks as 
easily as a real //e can! When you delete a file on your disk (or disk image), itʼs gone! 



You may be able to recover it with a disk utility program but itʼs much better (and a who-
le lot saner) to have a backup and restore it from that

Frequently Asked Questions (FAQ)

Q: The program complains about not being able to find a file called “APPLE2E.ROM”. 
What gives?

A: IIe does not contains the Apple //e ROMs because they are copyrighted material. You 
will need to either dump your own ROMs or get a copy of the ROMs that have already 
been dumped. See the section “Installation and Setup” above for more info about obtai-
ning them. Note that legally you cannot use the ROM file specified above unless you 
own an Apple //e.

Q: When I double click IIe, it starts up and then stops and Iʼm left back in the Finder. 
Whatʼs going on?

A: There was a problem during IIeʼs startup. The most likely causes are: Thread Mana-
ger not present or installed, out of memory, and corrupted preferences. Install Thread 
Manager if you are running a system prior to System 7.5. Try giving IIe more memory. 
Try deleting the preferences.

Q: The program starts up but then nothing happens. Whatʼs wrong?

A: When you start up IIe without any disks loaded into the drives, the //e is halted until a 
disk is inserted and the On/Off or Go/Stop icon is clicked.

Q: IIe starts up but then crashes/freezes/hangs/bombs/dies/stops working. Help!

A: Try these tips in the order shown:

1) restart with all extensions off by holding down the shift key until your Mac says “Wel-
come to Macintosh. Extensions Off.”. If this works, then one of your extensions is con-
flicting with IIe. If you find out which one it is, let me know (send email) and Iʼll try to fix 
it.
2) give IIe more memory
3) turn off (uncheck) the “Direct drawing” option in the video pane of the preferences. 
Some Mac video cards donʼt like this option when itʼs on (checked).
4) install a new copy of IIe and delete the “IIe Preferences” file in your Preferences Fol-
der (which is in your System Folder)



5) contact me with a detailed description of the problem and how to reproduce it. One 
request: you do not need to give me a 10 page list of your extensions; it usually is not 
helpful. If I need such a list, Iʼll ask you for it.

Q: It runs too slowly! Help!

A: try these suggestions in the order shown:

1) use the small window mode if you can
2) change to Black and White mode if your Macʼs video system supports it
3) change the video frequency to 20Hz instead of 30Hz or 60Hz
4) turn on direct drawing
5) increase the CPU speed in the 65c02 pane of the preferences
6) quit all other programs
7) turn off all unecessary extensions, including File Sharing, AppleTalk, Virtual Memory, 
etc., etc.
8) get a faster machine (sorry but thereʼs a limit to how fast any Mac can operate!)

Q: Talking of speed, why isnʼt IIe as fast as StopTheMadness on my 680x0 Mac?

A: IIe emulates an Apple //e and therefore requires a much more complicated memory 
scheme than StopTheMadness, which emulates an Apple II+. The price of being able to 
properly use 128K of Apple //e memory (or more) is that the emulator has to do more 
work to correctly access the memory. Result: slower performance than STM but more 
flexible and more powerful memory use.

Q: Talking of emulators, why isnʼt IIe an Apple IIgs emulator? Are there plans for this?

A: IIe was designed to emulate an Apple //e. Emulating an Apple IIgs is a lot more work 
and a much harder task. I have no plans for doing this and it is very unlikely I ever will. 
Instead, I recommend obtaining the FAQ of the internet newsgroup 
comp.emulators.apple2. There is mention in that document of the IIgs emulators cur-
rently in development (and yes, itʼs written for Macs).

Q: Some of the sounds that IIe makes donʼt sound right. What gives?

A: Emulating the Apple //e speaker is one of the hardest things to do right. IIe tries its 
best but may not always succeed. There isnʼt much that can be done about it. Most pro-
grams will sound OK and only a few will have problems. Choppy sounds may be due to 
too frequent video drawing or your Macʼs CPU being too slow. Slower Macs may not 
produce continuous sound - sorry, but they just donʼt have enough CPU speed to do it. 
Try these suggestions:



1) try using 30Hz or 20Hz instead of 60Hz (see the video pane in the preferences)
2) use the smaller screen
3) use direct drawing (see the video pane in the preferences)
4) turn off as many extensions as you can
5) turn off any networking software you can
6) quit as many programs as you can (and not just close their windows)
7) get a faster Mac (well I had to mention this option, didnʼt I?)

Q: What do the numbers at the top of the window mean? What do the red circles and 
squares mean?

A: These are the drive lights and slot/drive indicators. When an Apple II program acces-
ses the disk, the lights go on to tell you what is happening. You can click them to 
change the type of displayed lights (but clicking has no other effect on the program).

Q: The //e program Iʼm running suddenly stops, then a window labelled “6502 Debug-
ger” comes up and itʼs full of gibberish! What on earth is going on?

A: Your //e program has come across a “break” instruction or an illegal instruction (or it 
has reached a breakpoint that was previously set). The most common reasons for this 
are: a buggy program or a //e conflict (eg, the program youʼre using doesnʼt like the 
Clock card in slot 2). This situation is analogous to your Mac displaying the dreaded 
“bomb” dialog: the CPU is stuck at a place it canʼt continue onwards from. Itʼs fairly unli-
kely youʼll be able to continue the //e program and save any data but you may want to 
try: click the “Skip” button to skip over the illegal instruction. If it works, save your file 
and reboot the //e to start it up in a “clean” state. To exclude a //e conflict, remove all 
unneeded “cards” from their “slots”.

Of course, if you ended up in the debugger because of a breakpoint (itʼll say so in the 
bottom left corner of the window) then just clear the breakpoints and click the “Run” but-
ton.

On a final note, you can check the “ignore illegal instructions” checkbox in the 65c02 
pane of the Preferences to make IIe ignore illegal instructions.

Q: Why canʼt I get my program to work?

A: Some programs are “fussy” about your //e setup, and require certain hardware featu-
res. See the “Compatibility” section above for known incompatibilities and their work-a-
round.



Q: What does the Interrupt icon do?

A: This halts the //eʼs CPU and puts you into the 6502 debugger. From here, you can 
set breakpoints and follow the code as it is emulated. To exit the debugger, click the 
Run button (but remember to clear the breakpoints).

Most people wonʼt need to ever use this button. You will need to know the 65c02 in-
struction set to make sense of the 6502 Debugger window.

Q: Why is it that when I select a menu command with the mouse it works fine, but when 
I use the keyboard shortcut for that command then instead of doing anything, I get the 
key in the //e window?

A: when the //e emulator is running, all keystrokes are directed to the emulator window 
and menu commands are not interpreted. This is so that AppleWorks, Multiscribe and 
other programs which use “command-<key>” combinations will function correctly. To ac-
cess the menu commands from the keyboard, first halt the emulator by clicking the “Go/
Stop” icon or using the “Go/Stop //e” menu command in the File menu, then select your 
desired command, and then run the emulator by using the “Go/Stop” icon again.

Notes:

(i) if the “Go/Stop” icon or command is set up to function as an On/Off switch, then 
instead of halting the emulator, the icon will switch off the emulator and you will lose all 
of the contents of the //eʼs memory without any warning that this will occur. Be careful 
with this option!

(ii) if you have an extended keyboard, you can use the function keys to do many of the 
same functions that the menu commands do, and you donʼt need to halt the emulator to 
use them. Therefore, it is much easier to use the function keys if you can. See the file 
“2. Instructions” for details on what the function keys do.

Q: How much memory should I set IIe to use?

A: See the Installation and setup section above for a detailed answer. The “catch all” 
answer is 1700K, but it will need to be more if you set up IIe to use a RAM disk, etc.

Q: I changed the memory settings in the preferences but nothing happens. Whatʼs going 
on?

A: Changes to the memory settings wonʼt occur until IIe is restarted. Hereʼs how to 
change IIeʼs memory settings:



1) change the settings in the Memory pane in the IIe Preferences window and click the 
OK button
2) select Quit IIe from the File menu
3) increase or decrease IIeʼs memory requirements in the Finderʼs Get Info window
4) close the Get Info window
5) double click the IIe icon. IIe will then start up with the new memory settings.

Q: I have some Apple II disks. How do I get the programs to work with IIe?

A: If your disks are 3 1/2" disks, just run IIe and then insert the disk into the Macʼs floppy 
drive. IIe will ask you which drive you want to insert it into. Select a drive and then the 
disk is accessible just like on a real //e. Note that this assumes that you have already 
installed the UniDisk/Hard Disk card into a slot (see the Slots Pane section in the “Con-
figuring IIe” file for info on how to do this if you havenʼt).

If your disks are 5 1/4" disks, then youʼll need a real //e to transfer them to floppy disk or 
to a Mac via a serial connection. Please obtain the “comp.emulators.apple2” FAQ a-
vailable on the internet for a detailed description of how to do this. And if youʼre curious, 
the answer is “no, you canʼt use a IBM-compatible PC to read Apple II 5 1/4" disks”.

Q: How do I write Apple II programs?

A: You should be able to find a book on this topic from a library or bookshop. If not, ask 
your local user group or programming association. On the internet, post a (polite) mes-
sage to the newsgroup news:comp.sys.apple2.programmer

Q: Why doesnʼt the //e program I wrote work the way I want it to?

A: Itʼs beyond the scope of these documents to tell you how to program or what is 
wrong with it. See the answer to the last question for some resources that you can try.

Q: Where on the internet can I get the latest version of IIe from?

A: Use a World Wide Web browser to get it from:

  <http://www.usyd.edu.au/~vtan/index.html>

or

  <http://www.kagi.com/authors/vincenttan/>



The latest version is always at the first URL. If you donʼt have internet access, then try 
these suggestions:

• ask someone who has access
• use a “cybercafe”
• try a public library (many have WWW access now)
• try a BBS
• ask your local user group

Q: Where on the internet can I find some Apple II software or information?

A: Try these places:

  <ftp://grind.isca.uiowa.edu/> (hard to get in)

  <telnet:grind.isca.uiowa.edu>  (preferred method)

  <ftp://ftp.hypermall.com/pub/apple2/>  is a mirror of grind

  <ftp://ftp.asimov.net/pub/apple_II/> (hard to get in)

  <http://www.asimov.net/pub/apple_II> (much easier to get into)

  <ftp://ftp.uni-kl.de/pub/apple2/> (can be hard to get in)

  <ftp://friley131.res.iastate.edu/apple2/images/> (???)

  <ftp://wilbur.stanford.edu/pub/apple2/> (???)

  <ftp://apple2.caltech.edu/> (limited to 15 users, can also be accessed via gopher!)

  <news:comp.emulators.apple2>

  <news:comp.system.apple2>

I also recommend obtaining the document in this directory:

  <http://www.asimov.net/pub/apple_II/FAQs/>

it contains useful information especially about transferring data from an Apple II to a 
Mac/PC.

Q: I downloaded a file but it doesnʼt load or run. Whatʼs going on?



A: If you download your files from the internet or you get them in compressed format 
(you can tell because the files end in “.gz” or “.zip”) then follow these instructions to de-
compress them properly. I recommend using Internet Config 1.2, DropStuff with Expan-
der Enhancer 4.0 or later, and StuffIt Expander 4.0 or later, since the combination of 
these programs can decompress the files correctly when you set up Internet Config for 
suffix mapping.

To do this, run Internet Config and click “File Mappings”. Then add the file extensions 
“.dsk”, “.do”, and “.po”. For each of them, click the “binary data” (and not “Macintosh”) 
button. Then for “.dsk” and “.do” files, map them as File Type ʻDSK5ʼ and File Creator 
ʻAIIeʼ. For “.po” files, map them as File Type ʻDISKʼ and File Creator ʻAIIeʼ. Save your 
changes. StuffIt Expander will now be able to correctly decompress the files.

Next, configure your transfer program (be it an ftp client or a WWW client) so that files 
ending in .gz, .zip, .dsk, .do, and .po are downloaded as binary data and not text.

Next, if the file ends in .gz or .zip, decompress the file by dragging and dropping it on 
StuffIt Expander. They will be decompressed and come out as ready-to-use IIe disk i-
mages which you can double click to insert them into IIe.

See the section “Disk inserting/removing” in the files “2. Instructions” for more detailed 
instructions on the file types that IIe supports.

Q: Why should I register IIe? After all, I have it now and can use it straight away.

A: IIe is released as shareware. Youʼre free to try it out but if you decide to keep on u-
sing it, youʼre obliged to register. After all, itʼs a pretty good deal for you: you get the 
software and can use it without having to pay up front. Also, it isnʼt crippled or disabled - 
so what you see is what you get! On the other hand, unregistered versions remind you 
to register and have a time limit of one hour. :-)

I ask you to be honest about your use of IIe and pay the registration fee when you feel 
that you wish to keep the program.

Think about it from my point of view: this program was hard work. It wouldnʼt exist un-
less someone put in the time and effort to write it and make it work well and as bug-free 
as possible. Itʼs only fair that if a payment is requested then you pay for it if you think itʼs 
worth it. Also, paying the fee is very encouraging for me and allows further development 
to be done.

On a final note, payment is a quick and simple thing to do. Please see the last docu-
ment for details about how to do it.

Iʼll conclude with this: “thank you for supporting shareware”.
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Thank you for taking the trouble to try this program out. We hope you like it.

Note: this file is formatted and is best read with SimpleText and not TeachText.

Note: this file is not read-only so that you can easily copy the text if you want to. For e-
xample, you can copy the email addresses and URLs. Please donʼt modify this file or 
distribute modified versions.

Note: you should scroll up and down a pageful at a time so that the pictures will appear 
properly. If the pictures donʼt appear, you can make them appear by scrolling up a page 
and then back down a page.

This software is copyrighted material and therefore you are not allowed to modify this 
software or its documentation in any way, shape or form, nor can you sell it for your own 
profit. You may only charge a reasonable fee for the cost of distributing it. See the Dis-
tribution section below for information about how and on what IIe may be distributed.
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2. Instructions

Itʼs assumed that you know how to use an Apple II computer. That is, youʼre aware of 
how to switch it on, insert a disk, boot a disk, remove a disk, use the keyboard and use 
the joystick. If you know these things then youʼll find using IIe virtually the same as u-
sing an Apple //e except that the disk “insertion” and “removal” activities are virtual 
instead of real (unless you insert a real floppy disk into your Mac in which case itʼs real - 
hmmm, are you confused yet?).

If you donʼt know how to use an Apple II, just try using IIe anyway, but please donʼt send 
e-mail asking for this kind of help. Instead, trying posting a message to an Apple II mes-
sage board. Be polite and explain your ignorance of the Apple II. There should be some 
kind soul to help you out. If youʼre on the internet, try the USENET newsgroups such as 
ʻcomp.sys.apple2.<something>ʼ or ʻcomp.emulators.apple2ʼ.

The following instructions pertain only to features specific to this emulator.

The Apple //e window

 



This window is divided into several areas:

The display area

At the top is the status display area. It shows you the disk drive lights and which slot/dri-
ve they belong to and what image files you have loaded into them. To insert or remove a 
disk, you can click on the disk imageʼs name. With more cards installed in the //e, you 
will see more icons and names in this area (2 for the UniDisk/Hard Disk card (although 
4 is possible), 1 for the memory card, 2 for the MacProDOS card). At the bottom right of 
the status area is the ʻSoft caps lockʼ status line. You can activate the Soft caps lock 
feature from the IIe Preferences window (see the document “3. Configuring IIe” for in-
structions on how to do this).

The //e screen - screen snapshots

At the bottom left, of course, is the //eʼs display area which does the function of a real 
//eʼs video monitor. You cannot select anything in this area, but you can copy the con-
tents of the //e screen to the Mac clipboard from the Edit menu. You can also save the 
screen as a picture with the “Dump IIe Screen…” command in the File menu.

The icon buttons

At the bottom right are eight useful icons to make it easier for you to use IIe. They are:

• “Insert… F5” lets you select disk images, memory images, and folders for use in a //e 
drive

• “Remove… F6” lets you remove a disk image from a //e drive. Note that if you insert a 
disk image into a drive that already has a disk image in it, the old image is closed first.

• “Reset” simulates a press of the //eʼs reset key (you can also achieve the same effect 
by pressing control-delete on your Mac keyboard). This icon is disabled is the //e is off 
or not running).

• “Go F15” or “Stop F15” starts and stops the //e (freezes and runs it). This icon can also 
function as an on/off switch such that clicking it would be the same as turning off a real 
//e. When configured in this manner, it will be displayed as “On F15” and “Off F15”. See 
the “3. Configuring IIe” for instructions on how to configure it to do this.

• “Prefs… F7” opens the IIe Preferences window. If it has not been previously opened, it 
is opened at the top-most pane, otherwise it is opened at the most recent pane.



• “Slots…•-F7” opens the IIe Preferences window at the Slots pane to let you change 
the slots. However, changing the slots will not take effect until you quit IIe and start it up 
again.

• “Mono F13” and “Colour F13” changes the screen display from monochrome to colour 
and vice versa. You can also option-click the icon to change depths from 8 -> 1 bit 
depth, 1 -> 4 bit depth, and 4 -> 8 bit depth. You can also control-click it to change the 
display: if youʼre in monochrome mode, it changes the monochrome-white colour from 
white -> green, green -> amber, amber -> white; if youʼre in colour mode, it does nothing 
except in double hires mode in which case it will display a sharpened image (but this 
mode is slower than the normal unsharpened image).

• “Interrupt” halts the emulation at whatever instruction it is currently at and displays that 
in the debugger window. Donʼt use this icon unless you really need to, or unless you 
know what you are doing. Why use it? Well itʼs handy if you know 65c02 assembly and 
want to see what the processor is doing. Eg, “is it hanging or still reading the disk? I 
know! Iʼll check by interrupting it!” Warning: the debugger window is still in development 
and as such is still very much “raw” in its functioning.

Function keys

If you have an extended keyboard, you can also use the F-keys at the top of the key-
board. There are 15 such keys, numbered 1 to 15. Their functions are:

• F3: this is the same as selecting “Copy” from the Edit menu. It will copy the //e screen 
to the clipboard (including text if in text mode).

• F5: this is the same as selecting “Insert Disk…” from the File menu or clicking the 
“Insert…” icon.

• F6: this is the same as selecting “Remove Disk…” from the File menu or clicking the 
“Remove…” icon.

• F7: this is the same as selecting “Preferences…” from the File menu or clicking the 
“Prefs…” icon.
• option-F7: this is the same as clicking the “Slots…” icon. It opens the preferences and 
takes you to the slots pane, where you can add or remove Apple II peripherals.

• F8: this is the same as selecting “Save IIe Image…” from the File menu.

• F9: step over instruction (active only when the debugger window is active).

• F10: step into instruction (active only when the debugger window is active).

• F11: step out of instruction (active only when the debugger window is active).



• F12: if the debugger window is not active (the emulator is running and is not being de-
bugged) then this key will interrupt the emulator and control is handed to the debugger - 
it functions as if you had clicked the Interrupt button. If however the debugger window is 
active, then F8 will function as if you had clicked the Run button in the debugger 
window. The overall effect is to alternatively interrupt and execute the CPU.

• F13: this is the same as selecting “Mono/Colour…” from the File menu or clicking the 
“Mono/colour…” icon. You can also use the option and control keys to select extra opti-
ons (see Graphics modes below)

• F15: this is the same as clicking the “power switch” icon. Depending on what option 
the power switch is set to, it will either halt/run the emulator or power-on/power-off the 
emulator.

Graphics modes

• IIe shows you the //eʼs screen in a Mac window. This window should always be located 
on the same screen as your menu bar. If you have more than one monitor connected, 
please do not drag the window to a different monitor because IIe does not support mul-
tiple monitors.

• normal 40 column text, 40 column lores and “normal” hires graphics can be displayed 
in either a small 280 * 192 area or in a larger 560 * 384 area. You can alternate between 
the two sizes by clicking the windowʼs zoom box.

• 80 column text, 80 column lores and double hires graphics must be displayed in the 
large 560 * 384 window. You cannot switch to a smaller display whilst any of these mo-
des are active, and activating any of these modes (such as “PR#3 [return]” from BASIC) 
will make the emulator switch to the larger size.

• clicking the mono/colour icon button changes the display of hires graphics and double 
hires graphics from monochrome to colour and vice versa. It does not affect text or lores 
graphics. Naturally, this button does nothing if your Macʼs monitor is set to display black-
and-white (1 bit depth).

• clicking the mono/colour icon button whilst holding down the option key changes the 
depth of the Mac monitor. The depth is rotated from 256 colours (8-bit) to black-and-whi-
te (1-bit) to 16 colours (4-bit) and then back to 256 colours (8-bit).

• clicking the mono/colour icon button whilst holding down the control key changes the 
colour of the monochrome colour. Text is displayed in this colour and so will be affected, 
as will hires graphics and double hires graphics if the display is set to monochrome (by 
clicking the mono/colour icon button by itself). Note: control-clicking the icon does not-
hing if your Macʼs monitor is set to display black-and-white (1 bit depth).



Disk inserting/removing

You can insert different kinds of disks into IIeʼs “drives”. They can be real 3 1/2" disks, 
real ProDOS SCSI hard disk partitions, or disk images - a (Mac) file that “contains” an 
Apple II “disk”.

Using real disks

Inserting a real 3 1/2" disk

To use a real 3 1/2" disk, run IIe and when the “Apple //e” window is the front window, 
insert your 3 1/2" disk into any Mac drive. You will be asked if you wish to “insert” the 
disk into a “drive”, and if so, to select which “drive” to insert it into. Select your drive and 
youʼre set to use that disk.

Note that although you can insert a Mac formatted disk into the disk drive and then have 
IIe “insert” it into one of its drives, it wonʼt be very useful. For all practical purposes, you 
should insert a ProDOS formatted disk into IIeʼs drive (see below for info about Pro-
DOS). If you wish to transfer ProDOS files that are on a Mac floppy disk for use in IIe, 
you should use the “MacProDOS disk” peripheral which allows you to transfer files on a 
Mac disk or folder directly into ProDOS running on the //e.

Inserting a real ProDOS SCSI hard disk partition

To use a real disk, run IIe. If you have configured a UniDisk into one of the //eʼs slots 
and you have a real ProDOS SCSI hard disk partition on your hard disk, you will usually 
be asked if you wish to “insert” that ProDOS SCSI hard disk partition into a “drive”, and 
if so, to select which “drive” to insert it into. Select your drive and youʼre set to use that 
disk.

Using disk images

Introduction

To use a disk image, you need to prepare the file properly before you can “insert” it into 
a IIe “drive”. A short description of why this is necessary and how to do this follows.

On the Apple II, there are 2 main file systems: DOS 3.3, an older format (and probably 
the more commoner of the two) which usually supports only 5 1/4" disks; and ProDOS, 
the newer system which supports different sized disks. The order and format of data on 
these two systems are completely different from each other, and therefore disk images 
of disks in these systems are completely different in order and format from each other. 



As well, there is another file system called Apple Pascal, but isnʼt used much (Wizardry 
is probably the most famous program that used it).

5 1/4" disk images

Most of the disk images of 5 1/4" disks that are available on the internet are in “DOS 
3.3” order and are stored as plain compressed (usually gzipped) binary files. They usu-
ally have a “.dsk” suffix and are usually 143360 bytes when decompressed. So a typical 
file is stored as ʻcoolgame.dsk.gzʼ. This is for the benefit of PC users. When you down-
load such a file to your Mac and decompress it, the file is usually of the wrong Macin-
tosh file type and creator (for example, StuffIt Expander decompresses such files to 
SimpleText text files: type ʻTEXTʼ, creator ʻttxtʼ). To use the disk image file with IIe, you 
need to change the type to one that IIe can use. The fileʼs type should be changed to 
ʻDSK5ʼ and its creator to ʻAIIeʼ. When you do this, the file can be double clicked and 
then opened by IIe.

Dos 3.3 ordered 5 1/4" disk images can also have a suffix of “.do”. Again, change their 
type/creator to ʻDSK5ʼ/ʻAIIeʼ.

The other possible formats for 5 1/4" disks are:

• “ProDOS” order, usually with a “.po” or “.disk” suffix. Like Dos 3.3 order disks, they are 
143360 bytes long. Change their type/creators to ʻDISKʼ/ʻAIIeʼ for use in IIe, and
• “nibble” format. These images are usually 232960 bytes long. For example, another 
Apple II emulator for the Mac called “StopTheMadness” saves to disk images only in 
“nibble” format. To use them with IIe, change their type/creators to ʻNIBBʼ/ʻAIIeʼ.

3 1/2" disk images

Most of the 3 1/2" disk images are similar to the 5 1/4" disk images except that they are 
usually in “ProDOS” order. Aside from that, they are usually stored as plain compressed 
(usually gzipped) binary files. Again, they usually have a “.dsk” suffix. Again, theyʼll have 
the wrong Macintosh file type and creator. To use the disk image file with IIe, you need 
to change the type to ʻDSK3ʼ and its creator to ʻAIIeʼ. When you do this, the file can be 
double clicked and then opened by IIe.

For Mac users, a convenient format for 3 1/2" disks is the Apple Disk Copy format. This 
is the format that is created by disk imaging software such as Appleʼs Disk Copy 4.2 or 
Chad Magendanzʼs ShrinkWrap. Such disk images have “ProDOS” ordering. This for-
mat is different to the “plain” 3 1/2" disk image that is usually found on the internet. Disk 
Copy images have an extra 84 bytes of data at the beginning of the image to identify the 
imageʼs format. Disk images in this format have the file type ʻdImgʼ. This does not need 
to be changed for IIe to use them: you can drag and drop those files onto IIeʼs icon. 
However, if you want to be able to double click the disk image and have IIe open it, 
youʼll need to change itʼs creator to ʻAIIeʼ. The nice thing about this format is that you 
can mount these files on your Mac desktop if you have “ProDOS File System” or “PC 



Exchange” installed: you drag and drop the image on top of “ShrinkWrap” or “DropDisk” 
and it will mount on your desktop. You can modify the image if you mount it with 
“ShrinkWrap” but not “DropDisk”.

Note that DiskCopy images that are modified by IIe can be written out to real 3 1/2" 
disks with DiskCopy since the checksums are updated when you remove the disk image 
from the drive or when you quit IIe.

Hard disk images

Finally, there are disks stored in hard disk volume format. They usually have a “.hdv” 
suffix. They are ProDOS ordered files and are usually images of Apple II hard disks. 
There are in fact two hard disk formats. The more common one is a ʻplainʼ image, much 
like the plain floppy disk image mentioned above. Such images usually start with the 
hex bytes “01 B0 03” (use Norton Disk Editor to see this). These images should have 
file type ʻhdrvʼ and creator ʻAIIeʼ - the same as that used by ShrinkWrap 2.0 and Ima-
geMaster 1.0. If instead the image starts with the text “SimSystem” then it should have 
file type ʻHDV ʼ (note the space after the “V”) and creator ʻAIIeʼ.

Changing file types and creators

If you download your files from the internet or you get them in compressed format (you 
can tell because the files end in “.gz” or “.zip”) then itʼs quite easy to decompress them 
properly. I recommend using Internet Config 1.2, DropStuff with Expander Enhancer 4.0 
or later, and StuffIt Expander 4.0 or later, since the combination of these programs can 
decompress the files correctly when you set up Internet Config for suffix mapping.

To do this, run Internet Config and click “File Mappings”. Then add the file extensions 
“.dsk”, “.do”, and “.po”. For each of them, click the “binary data” (and not “Macintosh”) 
button. Then for “.dsk” and “.do” files, map them as File Type ʻDSK5ʼ and File Creator 
ʻAIIeʼ. For “.po” files, map them as File Type ʻDISKʼ and File Creator ʻAIIeʼ. Save your 
changes. StuffIt Expander will now be able to correctly decompress the files.

Next, configure your transfer program (be it an ftp client or a WWW client) so that files 
ending in .gz, .zip, .dsk, .do, and .po are downloaded as binary data and not text.

Next, if the file ends in .gz or .zip, decompress the file by dragging and dropping it on 
StuffIt Expander. They will be decompressed and come out as ready-to-use IIe disk i-
mages which you can double click to insert them into IIe.

To manually change a fileʼs type or creator, use a file type editor such as ResEdit (free 
from Apple), BunchTyper (free), FileTyper (shareware), or Aladdinʼs Desktop Tools 
(good quality commercial utility [biased opinion]).

How to insert and remove disks and disk images



After the disk image file is set up for use, there are several ways you can load it into IIe:

• you can drag it to IIeʼs icon in the Finder,
• you can double click the disk image (if its creator is set to ʻAIIeʼ),
• you can select “Insert Disk Image…” from the File menu (or click the “Insert…” icon 
button),
• you can drag the disk image to the drive you want to insert it into. If the image can be 
loaded into that drive, the drive imageʼs name will highlight when you drag the image 
over it; note that this only works in you are running System 7.5 or later, or have Macin-
tosh Drag and Drop installed in pre-7.5 systems, and
• you can click the drive image name of the drive that you want to load the image into. 
An open file dialog will then ask you to select the image to load.

IIe supports two 5 1/4" drives and two to four 3 1/2" drives for each installed disk drive 
“card”. You can have four 3 1/2" drives only if the UniDisk card is installed in slot 5, and 
the last two drives can only be available in ProDOS 2.0 or later.

You can remove disks by selecting “Remove Disk Image…” from the File menu or click 
the “Remove…” icon button. In the dialog that appears, select which disks you want to 
remove and click Remove. Note that you do not need to remove a disk before inserting 
a new one; newly inserted disks displace disks that are already in that drive (that is, the 
old one is automatically removed for you).

Loading and saving information - memory images

The best way to load and save your data is by saving it to a disk or disk image, which is 
done by selecting the save command in the Apple II program. However, there are some 
programs that donʼt let you save but there are times that you need to save what youʼre 
doing and return to it later - for example, youʼve spent the last 3 hours playing Lode 
Runner and you a wedding to go to. To solve this problem, IIe allows you to save its cur-
rent state by the use of “memory images”. In a nutshell, this operation takes a 
“snapshot” of the //eʼs memory and saves it on disk, where it can later be restored.

Note that the size of the saved image will be the size of the current //e memory including 
any extra auxilary memory you have allocated to the RamWorks III card. So if you have 
set up a //e with 1 Mb of auxilary memory, the saved image will be 64K (main memory) 
+ 1024K (aux memory). IIe will not save the contents of any Memory Card you install in 
a slot however.

When you ask IIe to load a memory image, it first checks that the size of the saved i-
mage is the same as the current memory setup. If it is, it loads it in and restores the //e 
to the saved state. Of course, you lose whatever you had in the //eʼs memory. You will 
not be warned of this loss because IIe assumes you know what youʼre doing when you 
open the memory image. If the memory imageʼs size does not match the current memo-



ry setup, then IIe will offer to load in only the first 128K or to cancel the load operation, 
and it will tell you what you need to set the memory size to if you want to load the whole 
image.

Emulator instructions

This section covers topics related to the use of the emulator and its peripherals.

Default settings

The default settings for IIe are:

• small screen
• no change in depth
• colour mode
• does not draw directly to your screen
• 1MHz speed
• 64K only of auxillary memory
• produces soft sounds
• no ʻdeleteʼ key translation
• no type-ahead buffer
• soft caps lock disabled
• joystick emulation via the keypad
• fast disk reads and writes
• ask what to do if a ProDOS hard disk is found
• the default Mac-ProDOS folder is the folder that the IIe program is in
• Disk II in slot 6 (fixed)
• 80 column card in slot 3 (fixed)
• no other cards installed

Starting up the emulator

If you start IIe with a disk (by double clicking the disk imageʼs icon or by dragging it to 
IIeʼs program icon), the emulator will start running as soon as it is ready and the disk is 
“inserted”.

However, when you start IIe without any disks in any drive, the emulator wonʼt run until 
you tell it to. You can start it up by clicking the “Run/Stop” icon button. Pressing it again 
will stop it. Alternatively, you can press F15. The icon will change to show you the state 
of the emulator. Of course, it isnʼt very useful without a disk…



Bonus: if you start IIe up with the command and option keys held down, then IIe will use 
the title of the //e window to show you how many 65c02 clock cycles it has emulated in 
each of its emulation cycles (which are about half a second long).

The Reset key

To “reset” the //e, that is, simulate the pressing of the reset key on a real //e, press con-
trol-delete (the delete key here acting like the reset key) or the “Reset” icon button. Tip: 
to force a “cold” reboot, press command-control-delete or command-click the “Reset” 
icon button. If you want to see the //e diagnostic test, press option-control-delete (or op-
tion-click the “Reset” icon button) (but the test is kind of boring in my opinion…)

The Keyboard

When the emulator is running, all keystrokes are directed to the //e window. When the 
emulator is not running, all keystrokes are directed to the IIe program, that is, the menu 
bar or the frontmost window. So if you press command-I to insert a new disk and not-
hing happens, be sure that the emulator is not running. If it is running, press control-esc 
or F15 or the “Run/Stop” icon button, to first halt it and then press command-I (or just 
click the “Insert…” icon button if you donʼt want to stop the emulator).

The ʻdeleteʼ key on the Mac keyboard can be configured to produce either a ʻbackspaceʼ 
or a ʻdeleteʼ key on the //e.

IIe implements a type-ahead buffer so you wonʼt lose keystrokes but some programs 
(especially games) donʼt respond with this on so you may have to turn it off. For text edi-
tors and word processors, youʼll probably want to turn it on.

The Tab key can be configured as a ʻsoft caps lockʼ key. If configured as such, then 
when you first press it, it changes any key you type from uppercase to lowercase and 
vice versa. When pressed again, it does not change the keys. In other words, it acts just 
like the real ʻcaps lockʼ key but the changes apply only to //e. This allows you to keep 
the real ʻcaps lockʼ key in your preferred position without having to change it every time 
you use another Mac program.

Paddles and buttons

The paddles/joystick is emulated by the use of either the Mac keypad or the mouse. If 
you have a joystick or gamepad attached to your Mac, you should set it to simulate the 
keypad.

If the keypad is selected to emulate the joystick, then:
• Keypad 7 is the same as pushing the joystick to the top-left



• Keypad 3 is the same as pushing it to the bottom-right
• Keypad 1 pushes it to the bottom-left
• Keypad 9 pushes it to the top-right
• The other keypad keys push it in between the corners

This arrangement works quite well - most programs have no problems with it.

If the mouse is selected to emulate the joystick, then moving the mouse around the 
screen will move the joystick in the same direction. You can configure the mouse paddle 
values to be based on the mouseʼs screen position or its position within the //e window.

This emulator uses a “smart” paddle emalation routine (technical weenies: it counts 
clock cycles), so all paddle/joystick reading programs should work. If you find a program 
that doesnʼt work well, let me know and Iʼll investigate it.

The “open” and “closed” apple keys on the //e keyboard (paddle 0ʼs button and paddle 
1ʼs button respectively), as well as the third paddle button are supported. The Mac keys 
to use are command, option and shift respectively.

Debugger instructions

Important: most people will not need to read this section for ordinary use of IIe. This 
section covers the use of the debugger which is a tool for seeing what the //e is doing at 
the machine instruction level.

If you end up in the debugger and donʼt know what to do, try clicking the Run button. If it 
fails, try clicking the Reset button. If that fails, youʼll have to power down the //e or quit 
IIe and restart it.

Currently the debugger is in a “raw” state, ie, incomplete and rough at the edges. 
However, you can use it to do some interesting things such as:

• set a breakpoint
• step an instruction
• step over an instruction
• step over all instructions in a loop and stop at the end of a loop
• step over all instructions in a 65c02 subroutine and stop at the point after the caller 
routine called the subroutine
• break on interrupts
• reset the //e
• run the //e
• disassemble memory
• change memory and the 65c02 registers



Oops. Iʼll get around to writing this section for the next release. Letʼs say that learning 
about the debugger “is left as an exercise for the reader” :-)
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3. Configuring IIe

One of the goals of IIe was to have a flexible and easy-to-configure //e emulator. To that 
end, it has many options which are presented in the following different categories. Each 
is shown as a separate “pane” within the IIe Preferences window.

To configure IIe, start it up and when the //e window is visible, click the “Prefs…” icon or 
select “Preferences…” from the File menu. You will then see the IIe Preferences window 
open up and General pane will be displayed.

In each displayed pane are some common buttons and controls. They are:

• the column of icons on the left of the window let you switch categories. Click on an i-
con to change categories or use the up and down arrow keys.

• the OK and Cancel buttons close the window and if OK is clicked, any changes you 
make are remembered. Clicking Cancel makes no changes to any preference you 
changed while the window was open. Pressing ʻreturnʼ is the same as clicking OK. 
Pressing ʻescʼ is the same as clicking Cancel.

• clicking the balloon help icon turns balloon help on or off. The icon changes appearan-
ce to reflect the current state of balloon help.

• clicking the Use Defaults button changes all the preferences that are currently shown 
in the window to their default state. It does not change any other preferences in any of 
the other panes.

• clicking the Revert button restores the preferences to what they were when the pane 
was initially displayed. This is a subtle but important point. An example: if you open the 
preferences window, change a preference, switch to another pane, then go back to the 
first pane, change that first preference again, and then click Revert, it will revert that first 
preference to the setting it was after you first changed it.

General pane

 



This pane controls some general options for IIe.

On/off switch behaviour

When you change this option, the icon in the “Apple //e” window will change its label to 
reflect the iconʼs functioning. The options are:

• Pauses and runs the //e: when this option is selected, the on/off icon (it looks like a 
power switch) will alternate between freezing and running the //e.

• Turn the //e on and off: when this option is selected, the on/off icon will behave like a 
real on/off switch. When the //e is on and running, clicking the on/off icon will switch it off 
immediately. Important: you will not be warned that you are switching off the //e and that 
any unsaved will be lost.

Warnings

• Warn about possible data loss when quitting IIe: when checked, IIe will ask you to 
confirm that you wish to quit from it. This is because when you quit IIe without saving 
any work or data you have made, you will lose that data. Having this option checked al-
lows you to abort quitting IIe and so gives you a chance to save any unsaved data. If 
you just want to quit without a dialog slowing you down, uncheck this option.

• Warn if the preferred auxiliary memory size is not available (in which case IIe starts up 
as a 128K //e): if the memory size given to IIe is too small, it may not be possible to al-
locate the requested auxiliary memory. As a courtesy, you can have IIe let you know that 
it failed to allocate the memory by checking this option. It will then present a dialog 



when IIe starts up informing you of the failure to allocate the memory. If the dialog an-
noys you, uncheck this option. To set how much auxiliary memory IIe should allocate on 
startup, go to the Memory pane (see below).

65c02 pane

 

This pane controls the 65c02 options for IIe (a 65c02 is the type of microprocessor that 
a real //e has).

Desired 65c02 speed:

Select the desired speed of the //e. Note that if you Macʼs CPU is too slow, you may not 
actually get the desired speed. In which case, youʼll either need to turn down the speed 
or get a faster Mac. I suggest the former if your wallet is thin. :-)

If you want IIe to go as fast as possible, use the Full option. Canʼt resist seeing how fast 
your PowerPC 604 is, eh?

CPU to emulate:



Some programs only work properly if a 6502 processor is emulated. Most programs will 
work fine with a 65c02. Some programs rely on a 65c02 processor.

Illegal opcodes:

Some programs use illegal instructions. Why? I donʼt know. Who knows why? Anyway, 
set this option on if the 6502 debugger window keeps bothering you.

For 680x0 processors:

The 68K version can use more memory for slightly faster performance that slower Macs 
may need. PowerPCs should be able to perform at least at 2-3MHz Apple //e perfor-
mance and these options are not available for PowerPC Macs. The options are:

• Uses 256K table; faster; for 68030s: selecting this option creates a table that makes 
the emulator go faster but of course it uses more memory. Recommended for 68020 
and 68030 Macs. Note that a 33MHz 68030 will get about 1MHz Apple //e performance 
and not much more than that so every speed up counts. Macs slower than this will not 
perform well.

• Does not use table; slower; for 68040s: selecting this option does not create a table. 
This option is recommended for 68040 Macs because they have enough speed to per-
form well without the need for the table, thus saving you 256K of memory which you can 
use for something else like a memory card.

Memory pane

 



This pane controls how much extra memory IIe will allocate when it starts up. Extra 
memory is usually used as a RAM disk. Using auxiliary memory as a RAM disk requires 
special “driver software” but does not use up a virtual “slot”. Using a memory card as a 
RAM disk does not require special software but does use up a virtual “slot” in the //e. 
Some programs know how to detect and use extra auxiliary memory and others know 
how to use a memory card. You should experiment with these options to find which is 
the most suitable for your use. As a general rule, youʼre probably better off using a 
“memory card” instead of more auxiliary memory but remember that you lose a slot by 
doing so. Also, you should remember to “install” the memory card in a “slot” using the 
Slots pane (see below).

If IIe fails to allocate the extra memory you requested (it only does this at startup), you 
will be alerted to this fact. If you want the extra memory, you will need to increase the 
memory size for the IIe program by clicking IIeʼs icon in the Finder and selecting “Get 
Info” from the File menu. In the window that opens, enter a higher number in the “prefer-
red size” text field.

Auxiliary memory:

Originally, Apple released //eʼs with 64K of memory only. Later on they started selling 
them with an “extended 80 column card” which included an extra 64K of memory called 
auxiliary memory. Building on this, some companies (such as Applied Engineering) re-
leased “super” extended 80 column cards that had more than 64K of memory. With the-
se options, you can have IIe “install” a super “extended 80 column card” with the selec-
ted amount of memory. Note that you cannot install less than 64K of auxiliary memory. 
In other words, the smallest //e that IIe will run with is a 128K //e.

Memory expansion card:

IIe supports a memory card up to 1Mb in size. It functions just like an “Apple II Memory 
Expansion Card”. The card will auto-detect what operating system you are using (Dos 
3.3, Apple Pascal or ProDOS) and configure itself to provide you with a RAM disk for 
that OS.

Video pane

 



This pane controls the video and display options for IIe.

Startup screen depth:

If speed is your concern, you can have IIe change your screen depth to a smaller depth 
for faster video drawing. Black & white is the fastest (but of course you canʼt see any 
colours). Millions of colours is the slowest. If you do change depths whilst IIe is running, 
then when IIe quits, the screen will be reset back to the depth it was in before IIe was 
started.

Startup window size:

The smaller screen is faster to draw but harder to read. 80 column text and double hires 
graphics must be displayed on the large window size and IIe will automatically change 
sizes if it is necessary.

Startup colour mode:

If you prefer a monochrome //e (I guess you must really love the “good olʼ days”), you 
can set IIe to give you a monochrome screen when you start up.

Drawing method:

IIe can draw the //eʼs video in two ways. It can draw it into an area of memory and then 
copy that image to your Macʼs screen (the indirect way) or it can draw it straight onto 



your Macʼs screen (the direct way). As you can imagine, direct drawing is faster becau-
se there is no need for the intermediate step of drawing it into an area of memory and 
then having to copy that memory image onto the screen. However, IIe comes with direct 
drawing OFF because a few Mac video cards donʼt like it when a program draws directly  
onto their video screens. Overall, most Mac video cards (or built-in video) will work fine. 
What you can do is try checking the “Direct drawing” checkbox and clicking OK. If IIe 
doesnʼt crash very shortly after you do this, then itʼs likely that direct drawing will work 
fine on your machine. If it does crash, itʼs likely that the video card doesnʼt like direct 
drawing so turn it off. If it crashes when you first start up after changing this option, you 
can disable it when you start up IIe by holding down the control key as you double click 
the IIe icon.

These are the conditions that must be satisfied for IIe to actually do direct drawing:

• the Apple //e window must be the front most window
• IIe must be the front most program
• no other windows must obscure the Apple //e window (including floating windows)
• the Apple //e window must be on the monitor that has the Mac menu bar on it
• the monitor that the Apple //e window is on must be at 1, 4 or 8 bit depths. Direct dra-
wing does not work when the monitor is in thousands or millions mode. Instead, indirect 
drawing will be used when the monitor is in those modes.

Tip: move the cursor out of the window so that it wonʼt flash as IIe tries to draw it. This 
applies to direct and indirect drawing.

Update frequency:

Some programs draw a lot and draw it quickly, in which case youʼll want IIe to draw fre-
quently. Be warned that if IIe spends more time updating the screen, then it will spend 
less time emulating a 65c02 resulting in less than desired performance. As the saying 
goes: “your mileage may vary”.

Sound pane

 



This pane controls the sound options for IIe.

Sound volume:

Thereʼs not much to say about this. Itʼs pretty self-explanatory.

The beep sound…

You can configure what sound IIe plays when a beep is made by a IIe program. Note 
that some programs use their own beep program instead of that in the Apple //e ROM 
and as such the sound you select may not be played.

Keyboard pane

 



This pane controls the keyboard options for IIe.

Pressing the ʻdeleteʼ key produces a…

• backspace (ASCII 8): if youʼre like me, you use the ʻdeleteʼ key on your Mac keyboard 
for moving the cursor back one character and removing the last typed character. Unfor-
tunately, the standard //e text line input program does not remove the last character 
when you type the ʻdeleteʼ key and instead it inserts a ʻdeleteʼ character into the line 
youʼre typing (it looks like a checkboard character). Most of the time, this is not what you 
want. To fix this, select this option to have IIe send the emulated //e a ʻbackspaceʼ cha-
racter instead of a ʻdeleteʼ character whenever you type the Macʼs ʻdeleteʼ key. This will 
make the cursor back up one character as you would expect it to do.

• delete (ASCII 127): there are some programs which can recognise the ʻdeleteʼ charac-
ter and use it for deleting things. For example, AppleWorks uses it for deleting text in its 
word processor module. In which case, select this option to make the Macʼs ʻdeleteʼ key 
to produce a ʻdeleteʼ character and not a backspace.

Use typeahead buffer (no lost keystrokes)

Most Apple II programs read characters from the //e keyboard in the standard Apple II 
way, in which case, you should check this option so that any key you type is saved until 
the Apple II program requests it.

Some Apple II programs (especially some games) donʼt read keyboard keys the stan-
dard way, resulting in the saved keys that you type never being sent to the Apple II pro-
gram. To fix this, uncheck this option. However, if you type too many keys too quickly, 
you will find that some of the keys are lost.

Soft caps lock:

Many early Apple II programs only understand uppercase characters. You could use the 
ʻcaps lockʼ key on your Macʼs keyboard but you would have to set it up or down every 
time you switch from IIe to another Mac program and vice versa. To save you having to 
do this, IIe supports a ʻsoft caps lockʼ in the form of the ʻtabʼ key. When this option is en-
abled (by selecting either the up or down options), IIe will treat the ʻtabʼ key as if it were 
a ʻcaps lockʼ key. Pressing it once reverses the state of the soft caps lock and pressing 
it again reverses it back to its original state.



Note: this option sets the soft caps lock keyʼs state only for when IIe is started up. If you 
change its state while using IIe, the new state is not saved.

Tip: if you need to use the ʻtabʼ key to produce a ʻtabʼ character (ASCII 9), then you 
must set this option to ʻoffʼ.

Joystick/Mouse pane

 

This pane controls the joystick and mouse options for IIe.

Source for joystick readings:

• Use Keypad: the keypad is used for the joystick. If Absolute is selected, then pressing, 
say, the 1 keypad key is the same as pushing the joystick fully down and fully left. If Re-
lative is selected, the pressing, say, the 9 keypad is the same as slowly moving the 
joystick towards its top right corner from where ever it currently is (it starts up in the 
middle position).

• Use Mouse: the mouseʼs position is used for the joystickʼs position. If Window is selec-
ted, then the value returned is the mouseʼs position within the Apple //e window. If Scre-



en is selected, then the value returned is the mouseʼs position on your Macʼs main 
screen.

Absolute joystick range:

You can specify what joystick values IIe can return to an Apple II program. Some pro-
grams require smaller ranges and others require larger ones.

Mouse options:

• Hide the Mac cursor when the Apple II mouse cursor is visible: when running mouse 
programs, it may be annoying to see the Macʼs cursor following the Apple II mouseʼs 
cursor around the screen. If this bothers you, check this option.

Warning: if the Mac cursor is hidden, youʼll find it very hard to click on icons or the menu 
bar because the mouse is hidden and youʼll need to guess where the mouse is on your 
Mac screen. To make the mouse visible and use it on the menu bar or in a window, just 
halt the emulator with the On/Off icon*, then use the Mac mouse as required/desired, 
and then let the emulator run by clicking the On/Off icon again.

* assuming that it is set to Go/Stop mode and not On/Off mode, of course. See the Ge-
neral pane for more information about the On/Off icon.

Printing pane

 



This pane controls the printing options.

Printer card options:

These options determine what the font, font size and paper size is for any printouts. It is 
recommended that you only use fixed-width fonts for the selected font. Such fonts have 
characters which are all the same width. The standard fixed-width fonts are Courier and 
Monaco.

The printer card prints to:

The printer card can be configured to print to either an attached printer or to a PICT file. 
You can print to a disk file to preview your printout before printing to a real printer.

Printing/capturing is finished when…

There is no known way for IIe to reliably know when an Apple II program has finished 
printing. You have the option of letting IIe automatically stop printing after a certain a-
mount of time or by manually pressing a key to signal to IIe that printing is finished. The 
automatic option can be disabled by unchecking the checkbox.

5 1/4" Disks pane

 



This pane controls the 5 1/4" disk options.

5 1/4" floppy disk image reading & writing:

• Fast - Dos 3.3 & ProDOS reads/writes are intercepted: Apple IIs do their disk reading 
and writing by software. This is could be emulated but is several times slower than if the 
reading or writing were done directly. If you select this option, IIe intercepts requests for 
reads and writes and performs them much faster than if the whole operation were emu-
lated. Most Apple II programs will function OK with this option. If you find a program that 
does not read or write as expected (you usually get strange I/O error messages) then 
deselect this option.

• Compatible - Dos 3.3 & ProDOS reads/writes are fully emulated: select this option if an 
Apple II program is not reading or writing properly. When this option is selected, all re-
ads and writes are fully emulated (and hence slower - sometimes much slower - than if 
they were intercepted).

5 1/4" floppy disk Disk II card ROM:

• Smart //c style ROM: this is a handy ROM because if you donʼt have a disk in the drive 
when the //e starts up, then the //e will continue to search the lower-numbered slots for 
a disk. Most disks can boot up using this ROM.

• Dumb II+ style ROM: some programs require the original Disk II ROM to be able to 
boot up at all. Such disks typically canʼt boot up on a real Apple //c. The disadvantage of 
this ROM is that if there is no disk in drive 1, then the //e will continue to wait forever un-
til you insert a disk or press reset.

Other Disks pane

 



This pane controls the remaining disk options. It allows you to configure how IIe loads 
disk images and ProDOS partitions, how it ejects real 3 1/2" disks, and where the Mac-
ProDOS folders are.

When opening a disk image with the “Insert Disk…” dialog, the default is to load it in 
to…

This is just a convenience option for when you have to swap disks a lot and the program 
that requests the swap thinks that you only have one drive, in which case selecting the 
“drive 1” option is very convenient. :-)

On startup, if a ProDOS hard disk partition is found…

Some hard disk formatting utilities such as Apple HD Setup program and FWBʼs Hard 
Disk Toolkit allow you to format part of your hard disk as a ProDOS partition. This is very 
handy for IIe because you can load all of your //e programs onto the partition and have 
IIe boot this up everytime you start up. Typically, you would “install” the UniDisk/Hard 
Disk “card” into slot 7 (or 5) and select the “Insert into drive 1” option shown here. See 
below in the Slots pane section for information about installing the card.

After “removing” a real 3.5" disk from a UniDisk drive…

When you remove a real 3.5" disk from a drive, you can either have IIe try to mount it on 
your Mac desktop (assuming you have either the ProDOS File System extension or Mac 
PC Exchange installed) or have IIe eject the disk from the drive.

The Mac-ProDOS folders for…

Wouldnʼt it be great if you could read and write to your Apple II files directly onto your 
Macintosh-formatted hard disk? Well you can. What you do is “install” the Mac-ProDOS 
“card” (see below in the Slots pane section to learn how to do this) and then select a 



folder on your Macʼs disk that will be the top-most directory of a pseudo ProDOS disk 
which will appear in whichever slot you install the “card” into. Note that because itʼs not 
a real ProDOS disk (itʼs a Mac folder that pretends to be a disk), not all ProDOS opera-
tions can be done. Programs that read or write files will work but programs that inspect 
or alter the diskʼs structure will not. For example, you can save word processor files in 
AppleWorks onto the “disk” but you cannot use Bag of Tricks 2.0 to check its volume 
bitmap, because it doesnʼt have one.

To set the folder to your desired folder, click the button and navigate to it. The selected 
folder will be set up when IIe starts up. You can change the current folder at any time by 
dragging and dropping a folder onto the IIe icon or by selecting it from the Insert… icon, 
but the newly selected folder will not be remembered after you quit IIe; only the folder 
specified in this preference will be remembered.

Slots pane

 

This pane allows you to set up which “card” goes into which “slot” of the //e. Doing this 
is easy enough: just drag the “card” you want to the “slot” you want it in. To remove a 
“card”, drag it back to its icon at the top.



The only special icons are the 80 column card icon and the slot 6 disk icon. You can on-
ly click the 80 column card icon to switch to a “40 column” card. Click it again to switch it 
back to an 80 column card. This is useful only to Apple Pascal programs which run bet-
ter in 40 column text mode (such as Wizardry). You cannot remove the 5 1/4" floppy 
disk card in slot 6.
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Cost/fee and registration

IIe 3.0.1 is released as shareware. That is, you can freely copy and distribute this versi-
on as you see fit, but you may not modify it nor may you charge more than a reasonable 
fee for distributing it. If you decide to keep it, you are then obliged to send in the regist-
ration form and the fee of US$30. On doing so, you will be sent a registration letter (pre-
ferably by email since it is faster and cheaper than normal mail) which will tell you how 
to register your copy of IIe. You may not distribute the registration letter or registered 
versions.

If you have registered a previous version (2.0 to 2.0.3) then you upgrade to v3.x for the 
small fee of US$5.

OK, so how do I register/upgrade?

1) Start up IIe. When the main window is visible, go to the Register menu and select “Fill 
in registration form…”.
2) Follow the dialog prompts and enter the required information.
3) If you wish to upgrade from a previously registered version, be sure to change the “I 
wish to register” menu to “I wish to upgrade”.
4) Save or print the form and send it and the fee (or the necessary information) to the 
shown email address or normal mail address. If you send email, you should receive a 
reply within a few days to a week (depending on the backlog). If you send normal mail, it 
may take a few weeks to process the form. Please be patient. If at all possible, please 
include an email address. You will get a much faster reply by doing so.

Version history

1.0 — Released Dec 21, 1995. First release. Project commenced Oct 23, 1995. All code 
except support for the internal floppy disk written by Vince. Support for the internal flop-
py disk written by my brother Victor - you know, the guy that wrote SpeedyFinder7 and 
co-authored CyberFinder!

2.0 — Released Mar 2, 1996. Major rewriting to add speed and features. Vince wrote: 
the PowerPC CPU, memory, floppy disk, UniDisk, user interface (dialogs and icons), 
preferences, about box, registration code, and these documents. Vic wrote: the 68K 
CPU, the graphics blitters, the sound code, the Memory card, the Mouse card, the Clock 
card, the Mac-ProDOS card, support for real floppy disks and SCSI hard disk partitions, 
and the 6502 debugger window. Whew.



2.0.1 — Released Mar 3, 1996. Fixed a bug causing crashes on 68K Macs when o-
pening the preferences.

2.0.2 - 2.0.3 — Released May 1996. Fixed a problem with 5 1/4" nibble disk images and 
booting 3 1/2" disks.

3.0 — Released June 30, 1996. Major update to add features and fix bugs. Vince wrote: 
the printer card, user interface (now supports drag and drop), preferences, support for 
more drives (Mac-ProDOS and UniDisk), and these documents. Vic wrote: the PowerPC 
CPU (now in full assembly) and the sharp graphics blitters (again, in assembly). Many 
bugs with the disk images, the clock card, the mouse card, and the memory card were 
fixed.

3.0.1 — Released August 6, 1996. Mostly a bug fix release with a few new features. 
Now supports keyboard input from the keypad when the joystick is the mouse and not 
the keypad; can now save the //e screen to a PICT file (the Dump command in the File 
menu); fixed problems with some programs like Wings of Fury; no longer crashes when 
printing with some programs.

Future version features

This is the list of possible features to be added in a future version:
 ? better video modes (small colour double hires)
 ? mockingboard support (coming soon I hope now that I've got one of the beasts)
 ? further serial card support (printing fonts, printing graphics)
 ? ability to save the memory cardʼs contents as a separate file/hard disk image
 ? display useful info such as track/sector being read or written

If you have an idea for a feature youʼd like to see, why not write and let me know about 
it? I know there are plenty of Apple II enthusiasts still around so why not help me make 
this a better program? Iʼm sure weʼll both enjoy the results.  :-)

Distribution

Disks and CD-ROMs

The unregistered version of IIe 3.0 and only the unregistered version may be distributed 
freely but it must be distributed in its entirety, that is, with this Read Me, and neither the 
program nor this Read Me may be modified in any way, shape or form. It can be put on 
disks and CD-ROMs. I (Vincent) would appreciate a copy each of any such disks or CD-
ROMs so that I know what it is being distributed on. Thank you.



I also ask that you contact me about the latest version so that only that version is distri-
buted.

WWW and other internet methods of distribution

The latest version is available at this internet World Wide Web location:

  <http://www.usyd.edu.au/~vtan/index.html>

or

  <http://www.kagi.com/authors/vincenttan/>

If you wish to add a link on your WWW page to this page you are most welcome to do 
so. On the other hand, if you want put the actual binhex on your WWW or ftp or gopher 
(or whatever) site for others to download then you can do so provided that only an un-
modified copy of the binhex on the above site is used. You may not offer a decoded ver-
sion nor may you decode it, change something (or nothing) and then recompress and 
rebinhex it - in other words: you may only offer the exact same file that is on this site.

Contacting the author

Please, if you have a problem with this program, read these documents first to see if the 
answer is already here! This will save both you and me a lot of time and trouble. Thank 
you for your help on this matter.

Otherwise, if you have comments, gripes, if you found something missing or something 
not clearly explained, or whatever... write to me and let me know your thoughts about 
this software. Iʼm always happy to answer your enquiry and improve this software.

To write via e-mail, send it to either of these (internet) addresses:

  <mailto:vtan@extro.ucc.su.oz.au>
  <mailto:VincentTan@kagi.com>  -  the mailer daemon here will re-route it the first 
address

Please put “Apple IIe” or “IIe” in the Subject line so we know what it's about. Thank you.

Other software by Vincent

• Jigsaw 2.1. Itʼs a cool shareware program that lets you play jigsaw puzzles on your 
Mac and has many options and features to keep you engrossed for hours. Itʼs certainly 

http://www.usyd.edu.au/~vtan/index.html
http://www.usyd.edu.au/~vtan/index.html
http://www.kagi.com/authors/vincenttan/
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better than the one you get with System 7.5 - “You call that a puzzle?” :-) Itʼs currently 
available in English, Dutch, French and German versions. (If you want to translate it, I 
can give you a registration for your efforts.) The latest version is 2.1•. A starter picture is 
included. Jigsaw can open PICTs, JPEGs, GIFs, and several other formats.

• Control Strip Menu 2.3.2. Make your Control Strip give you easy access to any file on 
your disk by popup menus of your favourite folders (similar to the many Apple Menu ex-
tensions currently available). Features: supports drag and drop; has “sticky menus” fea-
ture to make navigating folders easy; draws cool icons. Very handy to have. Shareware. 
Also available in German and Italian.

• AddGIFcomment 1.0.1. Allows you to add a comment to a GIF picture file. Freeware.

• AddJFIFcomment 1.0.2. Allows you to add a comment to a JPEG/JFIF picture file. 
Freeware.

• ResComparePatcher 1.0. Source code that allows you to create a ResCompare pat-
cher that can patch fat [68k & PowerPC] applications. Freeware.

On the internet, you can obtain the latest versions of these titles by using an ftp client to 
get them from:

  ftp://sumex-aim.stanford.edu/info-mac/game/jigsaw-20.hqx
  ftp://sumex-aim.stanford.edu/info-mac/game/jigsaw-21-updater.hqx
  ftp://sumex-aim.stanford.edu/info-mac/gui/control-strip-menu-231.hqx
  ftp://sumex-aim.stanford.edu/info-mac/grf/util/addjfifcomment-102.hqx
  ftp://sumex-aim.stanford.edu/info-mac/grf/util/res-compare-patcher-10.hqx

or better yet, use a mirror site such as <ftp://mirrors.aol.com/>

You can also get them by visiting this World Wide Web site:

  <http://www.usyd.edu.au/~vtan/index.html>

or

  <http://www.kagi.com/authors/vincenttan/>

The first WWW URL also has software by Vic on it, as well as useful links.

Disclaimer

I hate these. Anyway, itʼs the usual stuff:

ftp://mirrors.aol.com/
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Use at your own risk. The author accepts no liability for any damage caused. All other 
copyrights are held by their respective owners. Etc, etc, etc.

ʼTold you I hate them.

Arenʼt you glad I donʼt bore you with a License Agreement? :-)

Have fun, 

Vincent.

August 6, 1996.

PS: if you really want to know why I wrote this, itʼs because I got envious of the fact that 
other platforms had //e emulators and the Mac didnʼt. I thought it was sad that the com-
pany that made and sold Apple IIʼs no longer had any way of running Apple II software 
except by the IIe card for Mac LCʼs perhaps - and who can find one of those beasts no-
wadays?

PPS: why did Vic help? Because he loved working on it. Thereʼs just no doubt about it: 
Apple IIs are a lot of fun!  ;-)

PPPS: many thanks to all those who have written with problems and suggestions and 
thanks. Itʼs all appreciated greatly.
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